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AKVIS DRAW 9.0 | HAND-MADE PENCIL DRAWING EFFECT

AKVIS Draw lets you create hand drawn pencil sketches and line art pictures from your digital photos!

The software is incredibly easy to use; it makes a realistic looking drawing effect in just one click! Load your image into the
program and adjust settings to generate an artwork. The software creatively produces pencil strokes imitating an artist's
view.

 

Equipped with the ready-to-use presets and adjustable parameters, the program renders various esquisse drawing styles.
Besides creating black and white sketches, the software also lets you make color drawings.

The program offers the fastest way to convert a photo into a drawing. The result of automatic conversion can compete with
the work of a real artist. For more flexibility, the program allows editing the drawing with the eraser and pencil tools. You can
quickly remove extra lines, soften too sharp strokes, and add some finishing touches to your sketch.

Give a hand-drawn look to your pictures with AKVIS Draw!
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Play with built-in blend mode settings to let the photo show through the drawing! You can give your image a "comics" look or
achieve a watercolor pencil effect.

Using the selection tools you can limit the effect area and create an exciting combination of photo and drawing!
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The software supports the batch processing feature that lets you turn all your photos into a sketchbook or a storyboard
within just minutes.
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AKVIS Draw is available as a standalone application and as a plugin to a photo editor, in versions for Windows and Mac
platforms. A license defines the edition and functionality of the software.

- Standalone is an independent program that can be run by clicking on its icon.

- Plugin is an additional filter effect, intended to be installed into a photo editor, to increase its functionality:
AliveColors, Adobe Photoshop, Corel PaintShop Pro, or other compatible programs.

Take advantages of a free trial period and create variations of pencil art from your photos!

During the trial period you can try all options and choose the license you like.
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INSTALLATION

Follow the instructions to install AKVIS Draw on a computer with Windows OS:

Start the setup exe file.
Select your language and press the Install button.
To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

Press the Install button.
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The installation is in progress.

The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the
desktop, if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> Draw.
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INSTALLATION

Follow the instructions to install AKVIS Draw on a Mac computer:

Open the dmg file:

- akvis-draw-app.dmg to install the Standalone version

- akvis-draw-plugin.dmg to install the Plugin into your image editor.

Read the License Agreement and press Agree, if you agree with the conditions.

Finder will open with AKVIS Draw application or AKVIS Draw PlugIn inside.

 

To install the Standalone version, drag the AKVIS Draw app into the folder Applications (or any other place you
like).

To install the Plugin, drag the entire AKVIS Draw PlugIn folder into the Plug-Ins folder of your graphic editor:

Photoshop CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5: Library/Application
Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the Filter menu of your photo editor (in Photoshop: Filter ->
AKVIS -> Draw).

Run the standalone program by double-clicking on its icon in Finder.

You can also run the AKVIS program from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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HOW TO ACTIVATE AKVIS SOFTWARE

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS Draw and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Draw.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows 7/8/10:

Users\Public\Documents\AKVIS;

Mac:

Users/Shared/AKVIS.

Your registration is completed!
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change
Home to Home Deluxe or Business).
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WORKSPACE

AKVIS Draw can work independently as a standalone program as well as a plugin to a photo editor.

Standalone is an independent program; you can open it by clicking on the program's icon.

To launch the standalone version, run the program directly:

On a Windows computer - select it from the Start menu or use the program's shortcut.

On a Mac computer - launch the app from the Application folder.

Plugin is an add-on for a photo editor, for example for Photoshop.

To call the plugin, select it from filters of your image editing program.

The AKVIS Draw workspace looks like this:

Workspace of AKVIS Draw

The left part of the AKVIS Draw window is taken by the image window with two tabs: Before and After. In the Before tab
you can see the original photo. The After tab shows the resulting image. You can switch between the windows by left-
clicking on the tab with mouse button. To compare the original image and the result, click on the image and hold the button
pressed - the program will currently switch between tabs.

In the upper part of the program's window you can see the Control Panel.

The button  opens the home page of AKVIS Draw.

The button  (only in the standalone version) opens an image for processing. The hot-keys are Ctrl+O  on

Windows, ⌘ +O  on Mac.

Right mouse click on this button displays the list of recent files. You can change the number of recent documents in the
program's preferences.

The button  (only in the standalone version) saves image to the disk. The hot-keys are Ctrl+S  on Windows,

⌘ +S  on Mac.

The button  (only in the standalone version) prints the image. The hot-keys are Ctrl+P  on Windows, ⌘ +P  on

Mac.
The button  imports a list of user presets (from the .draw file).

The button  exports user presets. You can save any presets to a .draw file.

The button  (only in the standalone version) opens the Batch Processing dialog that lets you automatically

convert a series of images.
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The button  /  shows/hides the effect area outlines drawn with the tools.

The button  cancels the last operation with the post-processing tools (in the After tab).

It is possible to cancel several operations in a row. The hotkeys are Ctrl+Z  on Windows, ⌘ +Z  on Mac.

The button  returns the last cancelled operation. It is possible to return several operations in a row. The hotkeys

are Ctrl+Y  on Windows, ⌘ +Y  on Mac.

The button  is used to start image processing if the Autoran Mode is disabled.

The button  (only in the plugin version) applies the result to the image and closes the plugin.

The button  shows information about the program, version and license.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box.

The button  opens a window showing the latest news about Draw.

 

To the left of the main window there is the Toolbar. Different tools appear in the Before/After tabs.

Pre-Processing Tools (in the Before tab):

The button  (in the standalone program) activates the Crop tool. The tool lets you cut off unwanted areas in the

image. The tool's options are visible in the Settings Panel.
Effect Area . Use the blue pencil to draw an outline within the areas that will be converted to a drawing.

No Effect Area . Use the red pencil to outline the parts of the image that will remain in their original state.

Eraser . Use this tool to edit the outlines drawn by the pencils.

Post-Processing Tools (in the After tab):

The button  activates the Pencil which lets you draw over the result.

The button  calls the Eraser tool that erases the pencil strokes.

The button  activates the History Brush tool which lets you fade the effect and restore the image to its original

state (works under Home Deluxe/Business licenses only).

The options of the Pencil, Eraser, and History Brush are shown in a pop-up box which appears when right-clicking on
the image.

Additional Tools:

The button  activates the Hand tool (the hot-key is H ) which lets you scroll the image when it does not fit within

the window at the desired scale. Bring the cursor over the image, and while keeping the left mouse button pressed
move in the desired direction.
Double-clicking on the tool's icon  makes the image fit the window.

The button  activates the Zoom tool (the hot-key is Z ) which changes the image's scale. To zoom in click on the

image. To zoom out click with Alt .

Double-clicking on the tool's icon  makes the image scale to 100% (actual size).

 

Navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image which is
visible in the image window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the
visible portion of the image. To move the frame, place the cursor within it, left click the mouse, and then drag.

Navigator

Use the slider to scale the image in the Image Window. When you move the slider to the right, the image scale increases.
When you move the slider to the left, the image scale decreases.
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To scroll the image in the main window you can press the spacebar on the keyboard and drag the image with the left mouse
button. Use the scroll wheel of the mouse to move the image up/down, by keeping the Ctrl  key pressed – to the left/to the
right, by keeping the Alt  key pressed − scale the image. Right-click on the scroll bar to activate the quick navigation menu.

You can also change the image scale by entering a new coefficient into the scale field. The fall-down menu shows some
frequently used coefficients.

You can use hot-keys to change the image scale +  and Ctrl++  (⌘ ++  in Mac) to increase the image scale and -  and

Ctrl+-  (⌘ +-  in Mac) to reduce the scale.

 

Under the Navigator there is the Settings Panel with two tabs:

Drawing: Here you can adjust the parameters for photo to sketch conversion.
Decoration: You can add text to your image, adjust the canvas, and apply a frame.

 

Below, in the Presets field you can save the current settings as a preset to use them in the future. The current settings can
be saved, edited, deleted. When you launch the program, it uses the settings of the last used preset.

The Hints field will help you to understand how to use the program. The description for the parameters and buttons appear
when you hover over them with the cursor. You can choose where the hints will be shown or hide them in the program's
preferences.
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HOW TO USE THE PROGRAM

AKVIS Draw creates a work of art from a photo giving it a hand drawn look. The software is available in two versions: as a
standalone (independent) program and as a Photoshop plug-in filter.

To make a pencil drawing out of a photo follow the instructions:

Step 1. Open an image.

- If you work with the standalone edition:

The dialog box Select File to Open appears if you double-click on the empty workspace of the program or if you
click on the button . You can also use the hot-keys: Ctrl+O  on Windows, ⌘ +O  on Mac; or just drag the

image into the workspace of the program.

The standalone version supports JPEG, RAW, PNG, BMP, and TIFF file formats.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open.

Call the plugin from the menu of the editor:

In AliveColors: Effects -> AKVIS -> Draw;
in Adobe Photoshop: Filter -> AKVIS -> Draw;
in Corel PaintShop Pro: Effects -> Plugins -> AKVIS -> Draw;
in Corel Photo-Paint: Effects -> AKVIS -> Draw.

AKVIS Draw Workspace

Step 2. Before applying the effect, in the standalone version, you can use the Crop tool  to trim a part of the

picture. If you use the plugin, you can do this in your image editor.
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Crop Tool

Step 3. Adjust the settings of the photo to sketch conversion in the Drawing tab.

You can apply one of the ready-to-use presets or change the parameters to your liking.

The result will be immediately shown in the After tab.

By default, the Autorun Mode is enabled: any changes are displayed automatically. You can disable this mode in the
program's Preferences. Then you will have to press the button  each time to convert the image into a pencil

sketch.

You can interrupt the process by clicking on the Cancel button right to the progress bar.

Convert the image into a pencil sketch
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Processing Result Using Eraser

Convert the image into a pencil sketch

You can process only certain areas using the tools  and .

 

Define the effect area

Effect Area . Use the blue pencil to draw an outline within the areas that will be converted to a drawing.

No Effect Area . Use the red pencil to outline the parts of the image that will remain in their original state.

Eraser . Use this tool to edit the outlines drawn by the pencils. The tool can operate in three different

modes:

- Erase all strokes;
- Erase only red strokes;
- Erase only blue strokes.

Adjust the Size of the tools in a pop-up box that appears when right-clicking in the image.

Step 4. You can edit your drawing with the post-processing tools - Pencil , Eraser , and History Brush  in

the After tab. The tools' options are shown in a pop-up box which appears after right-clicking on the image.

Attention! Use the post-processing tools at the final step! If you re-run processing with the new effect settings,
the changes made with the tools will be lost.

The History Brush  is only available for the Home Deluxe and Business licenses.

Step 5. To make your drawing even more impressive, you can use the Decoration options: adjust the canvas, apply a
frame, and add text to your image.

Hint: The order of the application of Canvas/Frame/Text depends on the position of the tabs. Drag the tabs to
change the order.
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Step 6. If you like the settings, you can save them as a preset and use them later.

Note: The presets keep the parameters values of the Settings Panel. The actions made with the tools cannot be saved
to a preset.

Step 7. In the standalone version, you can also print your picture with .

Step 8. Save the processed image.

- If you work with the standalone edition:

Click on the button  to open the Save As dialog box. You can use the hot-keys: Ctrl+S  on Windows,

⌘ +S  on Mac.

Enter a name for the file, choose the format (TIFF, BMP, JPEG or PNG) and indicate the target folder.

- If you work with the plugin:

Press the button  to apply the result and close the plugin window. The AKVIS Draw plugin will close and the

picture will appear in the workspace of the photo editor.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format
and indicate the target folder.
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Result
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PENCIL DRAWING EFFECT PARAMETERS

AKVIS Draw lets you make a hand drawn pencil sketch from your photo. The program creatively produces pencil strokes
imitating an artist's view.

You can adjust the parameters for the photo to drawing conversion in the Settings Panel.

Pencil Drawing from Photo

 

Color Options:

Monochrome. The drawing is made with a single color and its shades.

Choose colors for the pencil strokes and the paper using the color squares. Click on the square to activate the
eyedropper tool, double click to open the selection color dialog. Use  to reset colors to default (black and white), 

to reverse the background and pencil colors.

Bright Colors. The drawing is created with bright, saturated colors. In this mode, you can change the background
color.
Natural Colors. The drawing is made using the original color range. The background is white and can't be changed.

Attention! Color changing is only available for the Home Deluxe and Business licenses. Owners of the Home license can
make just black and white drawings.
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Bright Colors Natural Colors

Monochrome

 

Effect Parameters:

In the Blend Mode drop-down list, you can define how the drawing will interact with the original image. The blend
amount can be adjusted using the Opacity parameter.

Attention! This feature is only available for the Home Deluxe and Business licenses.

AKVIS Draw

24

https://akvis.com/en/draw/comparison.php?utm_source=help


Opacity = 10 Opacity = 85

Regular Lines
(Сheck-box is disabled)

Refined Lines
(Сheck-box is enabled)

Multiply Mode, Opacity = 54

Refined Lines. The check-box changes the appearance of the pencil strokes. When this option is enabled, the ends of
the lines become thinner, the drawing looks more refined and elegant.

Extra Contrast. The check-box adds bright and clear lines to dark areas creating the ink effect.
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Without Extra Contrast
(Сheck-box is disabled)

With Extra Contrast
(Сheck-box is enabled)

Brightness = 20 Brightness = 90

Level of Detail = 30 Level of Detail = 80

Stroke Thickness = 5 Stroke Thickness = 25

Brightness (10-100). The parameter changes the color intensity of the lines.

Level of Detail (10-100). The parameter defines the amount of details and lines.

Stroke Thickness (3-30). The parameter defines the width of the lines.

Hatching Density (0-200). The parameter changes the number of the hatching strokes. Increase its value to enhance
the sense of volume.
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Hatching Density = 50 Hatching Density = 150

Sensitivity = 30 Sensitivity = 70

Curvature = 0 Curvature = 10

Dispersion = 20 Dispersion = 85

Sensitivity (0-80). The parameter affects the intensity of hatching.

Curvature (0-12). This parameter changes the form of the hatching strokes, from straight lines (value = 0) to curved
ones.

Dispersion (0-100). The parameter randomly changes hatching. Increase its value to make the strokes more weak and
thin.

Contour Detail (0-1000). The parameter defines the number of the small dark lines which complement the contours of
the drawing.
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Contour Detail = 0 Contour Detail = 900

Contour Brightness = 10 Contour Brightness = 90

Shadows = 1 Shadows = 30

Noise = 0 Noise = 70

Contour Brightness (1-100). The parameter changes the intensity of the contours.

Additional Effects check-box:

Shadows (1-50). The parameter enhances shadows giving your drawing more volume and depth.

Noise (0-100). The parameter adds graininess to the image.

Contrast (0-100). The parameter increases the difference between highlights and shadows. Using this setting, you can
get rid of unnecessary details and make the drawing look "cleaner".

AKVIS Draw

28



Contrast = -15 Contrast = 45
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CANVAS SURFACE FOR YOUR PENCIL DRAWING

Using the AKVIS Draw program you can put your pencil drawing to any surface: sanded paper, MDF board, brick wall, etc.

In the Decoration group switch to the Canvas tab, enable the Use Canvas check-box, and choose and adjust a texture for
your work of art.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Textured Paper

You can choose a texture from Library -> Surface or load your own sample: Library -> Custom…

Adjust the canvas settings.
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FRAMES FOR PENCIL DRAWINGS

In AKVIS Draw you can also add a frame to your pencil drawing to make your work stand out.

In the Decoration group switch to the Frame tab, enable the check-box of the same title, and choose the frame style and
texture.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Adding Frame

 

You can apply these frames to your drawings:

Classic Frame
Pattern Frame
Strokes
Vignette
Passe-Partout
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TEXT ON A DRAWING

You can personalize your drawing by adding a signature, create a postcard, insert a logo or a watermark to your image.

In the Decoration group switch to the Text tab and enable one of the modes: Text or Image.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Adding Text

Adjust the text/watermak settings.
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WORKING WITH PRESETS

AKVIS Draw includes a number of ready to use presets (settings combinations) for the draw effect which help you start
working. When moving a cursor over a preset in the drop-down list, the quick result appears in the small window on the left
side of the list.

A preset contains the settings of all tabs.

You can apply one of the AKVIS presets or modify the parameters to achieve the desired result.

To create your own preset, type a name for the preset into the field and press Save.

To return to the default settings of the selected preset, press Reset.

To delete your preset, choose it from the drop-down list and press Delete.

The AKVIS built-in presets cannot be removed.

You can save your presets to a .draw file with . To load presets from the file use .

Read more how to import and export user presets.
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box that looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Image Scale. This parameter defines the way the image is scaled in the main window after loading:

- Fit to View. The scale adjusts so that the image will be completely visible;

- 100%. The actual size is used, the image doesn't scale.

Recent Files (available only in the standalone version). The number of recent documents. The list of the recent files,
sorted by time, become visible by right mouse clicking on . Maximum: 30 files.

Hints Panel. You can choose how the hints will be shown:

- Under Image Window;
- Under Settings Panel;
- Hide.

Autorun Mode check box. If this box is enabled, any changes will be updated automatically.
If the mode is disabled, you will have to press the  button in order to see changes applied.

Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is selected
the panel is always visible.

To save changes made in the Preferences window press OK.

Click on Default to return to the default settings.
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BATCH PROCESSING

AKVIS Draw supports the Batch Processing feature that lets you automatically convert a series of images with the same
settings and saves you time and efforts. It is useful when creating a number of illustrations at the same style for a booklet or
when processing all frames of video.

 

Even if you've never used this feature before it is simple to learn!

If you use the standalone version of AKVIS Draw, read the instructions here.

If you use the Draw plugin in Photoshop, use this tutorial.
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PRINT IMAGES IN AKVIS DRAW

In the standalone version of AKVIS Draw you can print the image. Press the button  to open the Print options.

Print Options in AKVIS Draw

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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PENCIL DRAWINGS GALLERY

Have a look at the gallery of works made in AKVIS Draw. The software turns photos into pencil drawings using a smart
conversion algorithm. These pictures help to illustrate the possibilities of the program. Do you want to see your works of art
published? Send us your results!

 

Jogging

Original Image Black and White Drawing

Gothic

Original Image Black and White Drawing

Lady in Black
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Original Image Color Drawing

Portrait of a Girl by Sergey Maximenko.

Original Image Color Drawing

Midsummer by Sergey Maximenko.
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Original Image Color Drawing

Chess by Sergey Maximenko.

Original Image Black and White Drawing

Cheery Old Man by Liu Hui-zeng.

Original Image Color Sketch

Dinosaur by Liu Hui-zeng.
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Original Image Color Drawing

Fragrant Berries by Liu Hui-zeng.

Original Image Color Drawing
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DRAW GALLERY II

Have a look at the gallery of images converted to quick pencil sketches with AKVIS Draw. If you would like to submit your
images to be published, just let us know!

Fitness Girls
(open a larger version)

Musician
(open a larger version)
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Ethnic Beauty
(open a larger version)

Body Art
(open a larger version)
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Mom & Daughter
(open a larger version)

Basketball Player
(open a larger version)
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Sweet Tooth for Donuts
(open a larger version)

Horse
(open a larger version)
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Friends
(open a larger version)

Pretty Woman
(open a larger version)
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Portrait
(open a larger version)
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Original Photos Result

DRAWINGS IN THE MARGINS

AKVIS Draw opens up huge opportunities for creativity. Even if you don't have any drawing skills, with this software you can
create a sketch that has a real hand drawn look. Artists and poets often draw such light airy sketches in the margins of their
albums and diaries. Now you can easily fill your website or blog with beautiful pictures that will complement your stories or
poems.

We will show you how to create artistic works to illustrate a fragment from the poem "Stanzas to Augusta" by Lord Byron.

In the desert a fountain is springing, 
In the wide waste thee still is a tree, 
And a bird in the solitude singing, 
Which speaks to my spirit of thee.

Note that you need an image editor to combine the pictures into a collage. Or you can place the drawings directly to a web
page.

Step 1. Create a new image in the photo editor, for example, a white image of 800x1200 pixels.
Step 2. With the Text tool inscribe the lines of the poem.

Adding Text

Step 3. Open an image with a tree.
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Photo of a Tree

Step 4. Call the AKVIS Draw plugin from the menu: Effects -> AKVIS -> Draw. The program makes a hand drawn
pencil sketch from your photo.

Adjust the effect parameters. You can remove odd strokes with the Eraser .

Pencil Drawing in AKVIS Draw

Apply the result  and return to the image editor.

Step 5. Now, we need to remove the background. The easiest way is to use the Magic Wand - click on the white
area, then press the Delete -key.

Copy the tree to the page with the poem.

AKVIS Draw

49



Drawing of a Tree

Step 6. In the same way, add a bird to the picture:

Original Photo

Drawing of a Bird

and a female silhouette:
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Original Photo

Sketch Portrait of a Lady

Note: You can adjust a transparency for each image; all of them are located on different layers.

Step 7. Save the result.
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Poem with Sketches
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
original quality of compressed images. The software is available free of charge. It is a must for both home users and
professionals. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different painting techniques - Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any picture!
More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage — Add Color to Black and White Photos

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective colorization and
desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your
digital images. More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve
Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to
a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The
program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…
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AKVIS Magnifier AI — Change Image Size without Quality Loss

AKVIS Magnifier AI helps to resize images without loss in quality. Featuring neural networks based algorithms, Magnifier AI
enlarges digital pictures to super-high resolution and produces stunning wall-sized prints. More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…

 

AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
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includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…

 

AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…

AKVIS Draw

59

https://akvis.com/en/natureart-tutorial/effects/rain.php?utm_source=help
https://akvis.com/en/natureart/index.php?utm_source=help
https://akvis.com/en/neon/index.php?utm_source=help
https://akvis.com/en/neon/index.php?utm_source=help
https://akvis.com/en/neon/index.php?utm_source=help
https://akvis.com/en/noise-buster/index.php?utm_source=help
https://akvis.com/en/noise-buster/index.php?utm_source=help


 

AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…

 

AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…
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AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…

 

AKVIS Sketch — Turn Your Photos into Pencil Sketches
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AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, and Maestro, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist! More…

 

AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The
software considerably increases your productivity. You will be freed from boring work and will have more room for creativity
and realization of your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The software turns ordinary
images into amazingly realistic aquarelle pieces of art. More…
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